How to use ICC12 with Adapt812DX and FLASH Loader

This document will show and demonstrate the use of ImageCraft ICC12
Latest Version 6 with Technological Arts’ Adapt812DX module.

The MXFLash Loader is a utility to program the external FLASH of
Adapt812DX ,DXLT or Adapt812 + MX1 combo module. The file can be
downloaded at the link below.

http://www.interlog.com/~techart/myfiles/files/mxflash.zip

It will be used here to erase and program FLASH after the compilation of a
test program.

This document assumes that the user is familiar with C and so will not teach
how to program C here.
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Getting Started:

Double click on the ICC12 icon. If a user has not read the ICC12 manual and
just open the IDE one will wonder what to do next. Well wonder no more.

Note the 3 window panes. The top left most is greyed out and the right is the
project window. The left bottom pane is where the error messages are
displayed during compilation.

Before creating a new Project, the hardware target in the Compiler Options
must be setup properly for the target MCU. This is to ensure that the compiler
will setup the type of MCU the C program will compile for. In this example it is
the Adapt812DX, Adapt812DXLT or the Adapt812 + MX1 card.

* ' ImageCraft IDE for ICC1Z (PROFESSIONAL) -|ol x|
File Edit Seatch View Project RCS Tools Terminal Help
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Compiler Setup:

Click on Project Menu — Options — Target Tab.

* ImageCraft IDE for ICC12 (PROFESSIONAL)
File Edit Search VMisw | Project RCS Tools Terminal Help
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Please note the Device Configuration. Click on the pull down arrow to change

the device type.

Compiler Options x|

Faths I Compiler  Target I
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Scroll up or down to select Custom as shown. Note that an Adapt812DX
device Configuration does already exist. Unfortunately, the addresses are not
setup properly, therefore the Custom configuration must be selected and the
memory parameters are changed for proper operations.

In this example an Adapt812DX with 128Kbyte FLASH is used. Process are
the same for different FLASH sizes.

Compiler Options |

Fath= I Compiler  Target I

—Device Configuration FPRIMTF “ersion
|951 JDP25E 12K BAM Mode ;I £ srnall [int orly, no modifier]

Custom
9512Dx32 A Ax32 S C32
95120x=E4 / AxE4 £ HE4
951201258 A Ax128 A E128 —

£ long [+ long, and modifiers)
= float [full function)

95120256 / 44256 / H256 Aol Lz |
95120P256 4K EEPROM Mode _
9512DP256 12K RéM Mode ™ wiord Alignment
951204512 / fw512 || —advanced

[T Enable Addr IDHEDDDD-DHFFFFF Other Options I
[T Make Paged Functions Default [ Mo Startupslib

52 Record Type [Mon-default Startup I

i+ Linear [+ Map%ector Page
i~ CPU / Banked Address

For Expanded tMemary, "Linear 52" and "'tMap
Wector Page'' should generally be uzed. vou may
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E4F. of expanded memory. PRO werzion hasz no

Ok Cancel Set bz Defaultl Load Drefault I Help |

Device Configuration:

Program Memory: 0xC000
Data Memory: 0x7000
Stack Pointer: 0x0C00

The external memory area from 0xC000 to $FFFF is where the start of code
and the ISR must reside. Any interrupt routine must be in this area. Itis
possible to call routine in another PAGE while servicing the ISR,

The external memory area 0x7000 to Ox7FFF is RAM. The DPAGE is
enabled and is used to access the RAM memory in paged window.

The RAM memory area 0x0800 to OxOCOO is internal to the MCU. The stack
pointer will use this area.

Expanded Memory:

Note the address range is 0x10000. OX1FFFF for a 128Kbyte FLASH.
For 512Kbyte Flash the address range is 0x10000. OX7FFFF.



S2 Record Type:

Select Linear and check marked the Map Vector Page. 1CC12 will output
Linear S2 record.

Compiler Options |

Paths I Compiler  Targst I

—Device Configuratiar PRIMTF “ersiom——————————————

IEustDm LI & zmall [int only, no modifier]
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On the compiler tab there are several choices of S-record output as shown.
Select which one that suits you.
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Starting a new Project:

Once the compiler options are setup, a new project can be created. Click

Project menu — New.

* ImageCraft IDE for ICC12 (PROFESSIONAL)

File Edit Search View | Project RCS  Tools  Terminal
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The ICC12 will prompt to save the new project. The user should decide

whether to create a new directory to save the new project. In this example a

new directory called Test is created and the file is saved as file test.prj .

Save New Project As... 7] x|

Save in: | < Local Disk [C:]

x| & @ e EB-

Temp

Templ
Tempz
temp3
Ternpd
Temps

1

Chusr

[ WINDOWS
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File name: |

Open I
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j Cancel |




Type the filename as test.prj and click on the Save button.

Save in: I@ Test j = =5 Ef-

File narne: Itest.pri Cave

Save a3 type: | Project Files [*pr =l Cancel |

Note that the project window has changed to add Files, Headers and
Documents.

* ImageCraft IDE for ICC12 (PROFESSIONAL)
File Edit Search Wiew Project RCS  Tools Terminal Help

10 x|

LW+ 86 | 5eDzEE
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L2y Documents
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[513




Creating a new file to the project:

To add files to the project, click on the File menu — new as shown.

1ol
File Edit Search View Project RCS  Tools  Terminal Help
= CAEIT Y ===
Reopen... » Proiect | Browser |
Open... =-I¢C TEST
Reload. .. 3 =3 Files
R —— .21 Headers
Save Chl+S Loy Documernts
Save &5, .
Close
Compile File. .. 3
Save bl
Close all
Print
Exit
[[ Mo Open File 1 [CATestutest pri E3E]
Note that ICC12 created an untitled file. Save the file as BlinkLED.C .
1ol

File Edit Search View Project RCS  Tools Terminal Help

O %+ 56 58D s EE

Untiled - 3 | Preiect | Brawser |
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& Headers
Loy Documents

il |[CATesthtest. pri

519




To save, click on File menu — Save As

* ImageCraft IDE for ICC12 (PROFESSIONAL)
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ICC12 will open an explorer window to help save the file. Type BIinkLED.c
then press the save button.

Save in: I ) Test

~| = & o EB-

2=

File name:

Save az type:
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Source Files [F.c; " 1)

-

T
Cancel |

Save




Note that ICC12 has renamed the file to BlinkLED.c.

=
File Edit Search WYiew Projeck RS Tools Terminal Help
DEdw|+ 06 5 &0 = EE
BlinkLED.c | Project | Browser |
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3 Files
2 Headers
o3y Documerts
1:1 |C:AT esthBlinkLED. ¢ [CATesthtest pri [519 4
To add BlinkLED.c to the Project, click on the Project menu — Add File(s)
1o
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ICC12 will open an explorer window to help and locate the file of interest.

e
Look i | ) Test | « & cf E-

BlinkLED:.c

File name:  |BlinkLED.c Open |
Filez af type: IS::uurn:e Files [*.c. 5. "k j Cancel |

[~ Open az read-only

Note that the right window pane has changed to include BlinkLED.c under the
Files Project.

* ' ImageCraft IDE for ICC12 (PROFESSIONAL) o [=] |
File Edit Search Wiew Project RCS Tools Terminal Help

NEede |+ 65 |5 aD3EHE

BlinkLED.c | Fraject | Browserl
=-I¢ TEST
Bl Files
&
-3 Headers
w23 Documents
21 Modified |CATest\Biink LED .= |CoATesthrest pri BE] v

Locate vectors.c and copy file to Test directory. The major reason why this
must be done is because of project to project dependency. Itis not good to
keep editing a single vectors.c if other projects are using this same file. It
becomes a problem to keep track of the changes made to the different
projects.



To add vectors.c to the Project, click on the Project menu — Add File(s)

2

Loak in: I [ Test

-] & ® ok B

BlinkLED,
=

ckars.c

File name: Iveu:tu:urs.c

Open I

Filez of type: IS::uurn:e Files [".c. "5, % k]

[~ Open az read-only

j Cancel |

Note that ICC12 has changed to include vectors.c.
was written for the 68HC912B32 and 812A4 MCUs

Note that the vectors.c

* " ImageCraft IDE for ICC12 (PROFESSIONAL) i [=[ B
Fle Edit Search Yiew Project RCS Tools Terminal Help
R = —
HEdy +r6 QgDaEE
VECHs.C | BIinkLED.c' Project | Browser'
# DUMMY ENTRY, ﬂ EE TEST
* to Bl Filles
*  SCTHandler, & BlnkLED ¢
y &p vectorsc
#1f defined( HC12) g geade's t
/% add any interruot vectors in here too for HC1Z paged compilation HEUTEnLS
w
#pragma nonpaged function start
fendif
extern void _start (void): /% entry point in cet??.e v/
#define DUMMY ENTRY (void (%) (void))OxFFFF
#pragwa ghs_address: Oxefdd
/% change the sbove address if your vector starts elsewhere
#f
void [Ffinterrupt wectors[]) (void) = B
{
/% o cast a constant, sSay O0xbedd, use
{vold (*)())0xke00
#/
/% B1ii4 vectors starts at Oxf£f80, but most entries are not used
| if you use Key Wakeup H, change the start address to 0xffCE and
add one entry to the beginning */
DUMMY_ENTRY, /% BDLC */ /% Rey Wakeup J */
DUMMY_ENTRY, & ATD +/ STOATD %/
DTUMMY ENTRY, /% RESERVED +/ JFOSCIO1 Ot/ hd
q | B
85 [Modified [CATestwectors.c [\ Testitest pi [519 7




Write the codes below into BlinkLED.c file. Once it is written we can then
compile/make/build the code.

ol =
File Edit Search WView Projeck RCS  Tools  Terminal | Help
L = bl g2 | o B 50w B = B
wvectors.c  BIinkLED.c | Project | Browser |
#include "HCLZ.h" =]|| |=-1t& TEST
=1-E2 Files
void Blink_delay(wvoid)l ; g BlirkLED o
void m=ain() p weot
1
int i
PELR = OxO4 » F¢ Enable readswrite sSignal
MODE = OxEO A4 Mormal exp. narrow
WINDEF = OxC0O ; /¢ Enable data &£ program windows
MHLR = OxO7 F¢ Enable R16, A17, RB1S
CECTLO = 0Ox30 :; // Enakle CSD & CSPO
CSCTL1 = 0Ox10 ; /¢ CSD covers lower half of memory map
DDRT = OxFF;
PORTT = OxFF:
blink_delayi):

while (1)

PORTT = OxXFF: f/LED on
blink_delayi):
PORTT = 0O=00: £ /LED off

blink_delay() :

22:18 Modified |[C:ATestBlinkLED .o |C:hTesthTest.pry [s13

#include "HC12.h"
void blink_delay(void );

void main()
{ .
int i;
COPCTL = 0x00 ; /I Disable COP

PEAR = 0x04 ; // Enable read/write signal

MODE = 0xB0 ; // Normal exp. narrow

WINDEF = 0xCO ; // Enable data & program windows
MXAR = 0x07 ;// Enable A16, A17, A18

CSCTLO = 0x30 ; // Enable CSD & CSPO

CSCTL1 =0x10; // CSD covers lower half of memory map

DDRT = OxFF;
PORTT = OxFF;

blink_delay();

while (1)

PORTT = OxFF; /ILED on
blink_delay();
PORTT = 0x00; /ILED off
blink_delay();
}

}

void blink_delay(void)
{

int i;
for (i=0;i<64000;i++)
{

}
}
Compiling/Build/Make the file:



To make the file click Project menu — make project as shown.

* ImageCraft IDE for ICC12 (PROFESSIONAL)

File Edit Search Miew | Project RCS  Tools  Terminal  Help

g = = - B A 1=

Open... Chrl4+F11
vectors.e BIRKLED.e | cpen all Files Froiect | Browser |
Fincluae ~mc  Closs AllFiles = = I TEST
= B> Files
woid blink (o ooRen: " <27 BlinkLED.c
void maini) s e wectors.c
{ Rebuild All Shift+F2 ;22 Headers
. N 3 Documents
int 1: 0 addFiers.. Shift+F11
Add Tepmost Openad File
DDRP = pomove Selected Flle(s)
PTP = [
Options. ..
Llink_: Manusl Sort Browser Window
) Close
while (: Save As...
4
PTP = OxFF: FSFALED on
blink delaw():
PTP = 0Ox00: #/LED off

blink_delay():

r

void blink delay(veid)
:
int i; | |
for (i=0;i<1000; i++)
1

: Jid|

B [C:ATest BlinkLED. & [C:AT estitest.pri |519

Note the bottom window pane will show messages to display how the build
progressed. Any errors, if any, are shown in this window. The build was
without error so we can progress to erasing and programming the
Adapt812DX.

* ' ImageCraft IDE for ICC12 (STANDARD) [WARNING: 45 Days E¥ALUATION version ] i [=] 3]

File Edit Search Yiew Project RCS Tools Terminal Help

O W e & e®dsEEE

vectors.c BIRKLED.c | Froiect | Browser |
finclude "HC1Z . h™ BIE It TEST
=& Fies
void blink delay(woid); &2 BlinkLED.c
void main() e iZp vectors.c
‘ ) Headers
int i: -1 Docurnents

PEAR = 0x04 ; // Enable read/vrite signal

MODE = OxBO ;  // Normal exp. narcow

WINDEF = 0xCO : // Enasble data & program windows

MZAR = 0x07 ; // Enahble Als, 417, L18

0x30 : // Enable C3D & CSPO

0%x10 ; // ©SD covers lower half of memory map

CECTL1

DDRT = OxFF;
PORTT = OxFF;

blink_delay():

while (1) e
{

PORTT = OxFF; //LED on

blink delay():

PORTT = 0x00; //LED off

blink delay():

’ =l
icelzw —o -IC:\icclincludel —e -1 -Wf-cpdon C:)\Testivectors.c |
igelzw -0 Test -LC:hice)libly -btext:0xCO00 -bdata:0x7000 -bextcode:0x00000. 0x]
Done.
4| | »
75 43 CATest\BlinkLED.c [CATesthTestp [s19

Note the other extraneous files are created after a make.



x|
File: Edit ‘Wiew Faworites Tools Help | :f
O Back - &d = | ? ‘ P, ! Search :~L Folders | n \ﬂ | ..-'_.-' | Li:] _._I] X i
Address I;} ChTest LI [eTa]
Folders ¥ | _Mame = | Size: I Type I Date Modified I Dake Cre
gy o [4] BlinkLED. _c 1KE _CFile 10/21/2004 3:...  10j21)20
[E 2 23 i | C;l =
- p !@ ElinkLED.c 1 KB C source file 10/2172004 3:... 10j21/20
Eog [ BlirkLED dpz 1 KB DPZ File 10/21/2004 3:...  10j21)20
: F:| BlinkLED:. lis 3KE Text Docurnent 10/2172004 3:...  10j21/20
= BlinkLED 0 1KE O File 10/21/2004 3:...  10j21)210
%] BlinkLED 5 ZKE ASMFile 10/z1/2004 3., 10f21/210
= test Ik 1KE LK File 10/21/2004 3:...  10/21)210
= st Ist 4KE list File 10/21f2004 3., 10f21/210
=] test.mak 1 KB MAK File 10/21/2004 3:...  10j21)210
[#] test.mp ZKE MP Fil 10fz1f2004 3., 10f21/210
%] test pri 1 KB EmbeddedGMU Proj... 10/21/2004 3:...  10/21)210
etest.s19 | 1KE 513File 10/21/2004 3., 10/21/20
=) TEST . SRC 1 KB SRE File 10/21/2004 2:...  10/21)210
@ wveckors.c ZKE  source file FIT7z002 2:3...  10j21)Z0
=] vecrors.dpz OKE DPZ File 10/21/2004 3:...  10j21)20
[%”] veckors,lis 2KE Text Document 10/21/2004 3.,  10JZ1)20
@ veckors.o 1KE O File 10/21/2004 3:... 10j21f2(0
mvectors.s 1 KB ASM File 10/21/z004 3:... 10jz1/z0
| %] est. prideflcciz.pri 1 KB EmbeddedGMU Proj... 10/21/2004 3:... 10/21)21
< | »

Using WordPad to check the content of test.s19 file. Note that the S-records
are of different lengths. In reality the test.s19 record is an S2 type.

S20F01C000CFO0C0016C07387CE70008EBS8
S21101C00B700027056A000820F6CECO078CD2B
S21201C01870008EC0782706180A307020F516C4
S20801C026C02A20FEOQ8
S21101C02A34B7751BO9EC6047BO00AC6BO7BAA
S21201C037000BC6C0O7BO0O37C6077BO038C6303C
S21201C0457B003CC6107BO03DC6FF7BOOAFC6ED
S21101CO53FF7BO0OAE4A8000042010C6FF7B74

S21001CO6000AE4A8000047900AE4A800061

S20B01C06C0420EEB757303D3A
S21201000034B7751BO9ECCO0006C1E2007EC1EAC
S21201000EC300016C1EEC1E8CFA0025F2B757DB
S20601001C300AA2
S21201FFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFF2B
S21201FFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFFLD
S21201FFECFFFFFFFFFFFFFFFFFFFFFFFFFFFFOF
S20A01FFFAFFFFFFFFCOO03F
S20901C0731D0016073D4B

S903C0003C




Programming the Adapt812DX:

Any terminal program can be use to communicate to the FLASH Loader. In
this example ICC12 is used. Connect Serial cable to any available PC COM

port and the other end to Adapt812DX.

Click Terminal menu — Show Terminal window as shown

*  ImageCraft IDE for ICC12 (STANDARD) [WARNING: 45 Days EYALUATION version | i ]
File Edit Search “iew Project RCS  Tools | Terminal Help
e e | o+ [ | Show Terminal window H
Clear Windaw .
wectors.c BIRKLEDL: | _— Proiect | Browser |
| =]|| [5 T Test
DDRT = OxFF; EI & Files )
PORTT = OxFF: i eZp BlinkLED.c
L4 vectars.c
. R -3 Headers
blink delawi): Lofy Documents
while (1]
H
PORTT = OxFF; A/LED on
blink delayi);
PORTT = Ox00: //LED off
blink delaw():
¥
H
void blink delayivoid)
i
int i:
for (i=0;i<64000; i++)
{ =l
icolzw —c —-IC:4yicedincludey -2 -1 -WE-cpdon C:h4Testlwvectors.c
icolzw —o Test -LC:hiceo' libkh —htext:0xCO000 -bdata:0x7000 -hextcocode:0x000
Done.
1] | r
391 |C:\TesthBlinkLED.c |[CATesthTest.pri [s19 i
Note that ICC12 will immmediately change to show terminal window.
*  ImageCraft IDE for ICC1Z {STANDARD) [WARNING: 45 Days E¥ALUATION version | o ] 4|
File Edit Search View Project RCS Tools Terminal Help
—— = —
hicdes s 66 &&DnEE
ﬂ Download File: et | Erowserl
I =-JEE TEST
B2 Files
Erowge.. &7 BlnkLED.c
kg wectors.c
Dovinload! -3 Headers
3 Documents
Open Com Port
Show Editors
-
KN D
ioelziw - -IC:4yiccehincludey -2 -1 -Wi-gpdon CihyTesthiveccors.c AI
ieelzw —o Test -LC:%iech libh -btext:0xCO00 -bdata:0x7000 -hexteoode:0x000
Done.
-
< | »
[T erminal window [CATest\Test pri [519 v

Setup the terminal BAUD by clicking on Tools menu — Environment options as



shown.

* ImageCraft IDE for ICC12 (STANDARD) [WARNING: 45 Days EVALUATION version | =] |
File Edit Search Yiew Project RCS | Tools Terminal Help

D B“ = | @ | cé’ q Environment Options. .. E |

Editar and Print Options

ﬁ S T hload File: Froject | Browserl
: =T TEST
Run... Iee .
Files

<7 BlinkLED.c

Browse... |
7 vectors.c
Download! | : 23 Headers
L2y Documents

Open Com Part |

Show Editars |

g o

ieolZw —o -IC:hicchincludey -e -1 -WE-cpdon C:hTestlwvectors.c
icclZw -0 Test -LC:bieed libhy —btext:0xC000 -bdatz:0x7000 -bextcode:0x000
Done.

I | Terminal wWindow |C:\Test\Test.pri |519 4

Select the Terminal Tab and the set the BAUD = 9600, Flow control = None,
ASCII Transfer Protocol = None. Select the COM that the serial cable is
connected to at the back of the PC.

Environment Options El

Preferences  Teminal |

COM Polt——— —Flows Control

f+ COM 1 i+ Mone

= COM 2 " Hardware [CTS/RTS)
 COM 3 " Software ["5/70)

= COM 4 i~ Keep DTR Active

Baudrate: —ASCH Transfer Protocol———

IEIEEIEI - I * None

" Line delay (mz) |10
e | € wait for " [Flash]

Help |

OE. |

In the middle of ICC12 is the Open COM Port button. Push the button to open
COM port as shown. Note that it will change to Close Com Port.




* ImageCraft IDE for ICC12 (STANDARD) [WARNING: 45 Days EYALUATION version ] (=]
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The MCU must boot up in single chip mode in order for the Loader to work.

Set the various jumpers as indicated below.
Jumper settings for MODA and MODB for single chip mode.

JB1 — pin 2 and 3 shunted — MODB
JB5 — shunted — MODA
SW3 to SGL (single chip) position.

Jumper settings for FLASH and RAM with REVO to REV2A

JB3 — pin 1 and 2 shunted
JB4 — CSPO* and F shunted
JB6 — CSD* and R shunted

Jumper settings for FLASH and RAM with REV3

JB3 — pin 1 and 2 shunted (CSD* RAM enable)
JB6 — pin 1 and 2 shunted (CSPO* FLASH select)
JB7 — pin 1 and 2 shunted (RAM write enable)

Connect Serial Cable to COM 1 at the back of PC and to the Adapt812DX.
Slide SW2 Run/Boot switch to Run position. Make sure SW3 is in SGL
position.




Power up the Adapt812DX board with a known good power supply, making
sure the PWR LED is on. Once the board is powered, ICC12 Terminal should
display the MXFlash Loader menu as shown.

Notice that it detected the FLASH to be AMD Flash Device . If the Loader
cannot detect a FLASH memory it will display unknown Memory and will
assume that the memory is RAM.

There are several things to check if the Menu will not show up as shown
above.

Do not use NULL cable. Use a straight thru cable.

Check and verify the cable is connected to the correct COM port.
Re-boot the PC if necessary as other application may have corrupted
the OS.

Use known good serial cable.

If there are other problems, test the COM port with another device that
is known to work.

If the FLASH type is not recognized re-check jumper settings. If still
unrecognized then the board has a problem.

Erasing:

To erase the FLASH the command is E.



Programming:

There are 2 options for programming the FLASH. The 1% is whether the S-
record is BANKED. The command is N to toggle from BANKED to NON-
BANKED. ICC12 creates mixed S1 and S2 record. This is generally called
BANKED mode. One should always check the S19 record to see if there are
S1 and S2 mixture. Other compiler creates BANKED S2 too. One should
experiment whether to program the S-record as BANKED or NON-BANKED.

By choosing the N command the loader will always toggle from previous state
to the next. By default it is set for BANKED mode.

If the S-record contain only addresses from $C000 to $FFFF then it should
always be programmed as NON-BANKED. Linear S2 record must always be
programmed as NON-BANKED.

Note: For ICC12 the S2 record is programmed as BANKED.

Type P to initiate program.



Use the Browse button to help locate the file to be uploaded.

Select the Test.s19 file then press the Open button.

Once selected the Download button will now become active.



After programming, slide SW3 to EXP (MODA = 1) then press the RESET
button. The programmed application in now running in expanded NARROW
mode.

Checking DATA in Load mode:

The command is F for memory dumping DATA from FLASH. This is used to
check certain parts of the memory.

For example, one may want to check the address from $C000 to $FFFF. How
Is this possible? There are few things that needs to be understood. The
memory block $C000 to $FFFF is always present in the memory map. This is
where the ISR and start of code resides. When servicing an ISR it is possible
to access a different PPAGE. With 128Kbyte Flash, the $C000 to $FFFF can
be access at PPAGE = $07 in the page window $8000 to $BFFF.

For 512Kbyte Flash, the $C000 to $FFFF can be access at PPAGE = $1F in
the page window $8000 to $BFFF.

Here is an example to dump $C000 to $FFFF with a 128Kbyte Flash. Select
F command then type the value 07



Immediately after it would begin to dump the DATA beginning at $8000 to
$BFFF. Please note that PPAGE = $07 at $8000 to $BFFF is the same as
$CO000 to $FFFF

Below is at the end of DATA dump.



Note that at address $BFFE:BFFF is equal to $FFFE:$FFFF. The value is
seen to be $CO00 the start of code.

This tool is implemented to help diagnose where are the DATA being
programmed too from an S-record file.

Executing Program in Load Mode:

The command is G to execute the already program code. The Loader will
fetch the address at $BFFE:$BFFF (PPAGE set at the Last page) then start
executing the code at that address. For example, if the value was $C000, the
loader removes the EEPROM out of the memory map, read the vector
address and make Register X equal $C000 and jump to $C000 with Register
X.

Note:
In load mode certain registers are initialized. The stack is set to $0C00,

MODA:MODB in expanded narrow mode including the various expanded
register controls. Lastly the COP control is disabled.

Problems:

Q. Programmed okay but will not appear to run.



A. Toggle from BANKED to NON-BANKED or vice-versa then erase and re-
program again.

Q. Tried to program in BANKED or NON-BANKED, Flash programmed OK
but will not work.

A. There are 3 things to check.

1. COP control needs to be disable if not being serviced.

2. Check if the Stack is initialized

3. Check if the Power ON reset vector is correctly pointing to start of code.

Q. Programmed OK and runs with G command but not in Expanded mode.
A. Check the stack is initialized and COP control disabled if not being
serviced. Inload mode the stack is initialized and COP disabled. Make sure
to slide SW3 to Expanded Narrow mode.

Q. During programming the red LED comes on

A. The Loader is unable to program into a memory location. The reasons are
many. The S-record may contain code that are manipulating the registers.
The S-record may contain addresses that are outside the bound of the FLASH
chip. Lastly, the FLASH memory maybe faulty.

Q. Programming Rev3 is different from Rev2A.
A. Verify the jumper settings FLASH and RAM

JB3 — pin 1 and 2 shunted (CSD* RAM enable)
JB6 — pin 1 and 2 shunted (CSPO* FLASH select)
JB7 — pin 1 and 2 shunted (RAM write enable)



